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This document is designed for users who are familiar with the functionality and shortcuts in Photoshop 3.0

software and want to understand some of the changes in version 4.0. This is not intended as a manual, but

is instead a reference tutorial that examines the operations that underwent changes from Photoshop 3.0. For

detailed explanations of new features or how those features work, please refer to your user’s guide.

Faster Compositing With Image Caching
Image caching and the resulting compositing speed is one of the new features of Photoshop 4.0. The new

image cache scheme in Photoshop 4.0 greatly decreases the time and the amount of RAM it takes to composite,

move, and lay out high-resolution data.

See for yourself: In Photoshop 3.0, open a high-resolution, layered image file. Open the file under small

memory conditions, such as 24 MB. After the file opens, watch how long it takes to composite the layers on-

screen at 1:4 or 25 percent magnification. Now, with the Move tool, link some layers together and try moving

the layers around. Notice how much feedback you get—usually an outline of the layers. After moving the

layers, set the opacity to about 50 percent, and then change the blending mode.

In Photoshop 4.0, do the exact same things. Notice what kind of feedback you get, as well as how fast you get it.

The difference is more than obvious. The speed gain for basic functions is fairly significant. Currently, only

certain functions are sped up, like compositing, layering, and adjustment previews. Filters are also sped up in

that the time to composite the filter result with other layers is decreased.

This new image architecture does not speed up painting or the actual task of calculating a filter adjustment,

but the advantage here is that you can much more quickly get a sense of what you are doing.

Pasting, Dragging and Dropping, and Creating Text as Layers
(Less Reliance on Floating Selections)
Layers functionality is probably one of the more basic changes in Photoshop 4.0, and it may take some time

to get used to. Many Photoshop books and seminars discuss using layers effectively, which allows you more

flexibility to be creative in your work.

In Photoshop 4.0, whenever you paste from the clipboard, create text using the Type tool, or drag and drop

data from one document to another, Photoshop 4.0 creates a new layer with the data (when you are working

in formats that can use layers; otherwise, Photoshop creates a floating selection, as with Indexed Color). In

Photoshop 3.0, performing any of these tasks would create a floating selection, which would automatically

defloat once it was deselected. Mastering floating selections was one of the more difficult things to learn
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about Photoshop, mostly because floating selections are error-prone and allow you only a one-shot attempt

at moving data around to get an effect right. You could accidentally deselect the floating selection by clicking

the wrong spot, or have the floating selection clip itself once it was defloated into the layer below, or have a

feathering command on the floating selection cause the data to be rendered into the layer.

Try this in Photoshop 3.0:

1. Paste an object or create some text.

2. Hide edges.

You can do this to remove the marching ants, which can be distracting when you’re trying to line

up edges.

3. Hold down the Command key (Mac) or Control key (Win) and remove a portion of the floating

selection.

Try to use the Shift key to add back portions accidentally removed. You see that you can’t do this because

Photoshop removes the data from the selection. Instead, you have to immediately undo to add back what was

lost, and then go through a process of guessing to bring more than is needed back in and then remove it.

4. Now click and drag to move the data.

If, at this point, you accidentally missed a portion of the selection with the cursor—something that can happen

easily with heavily feathered selections or small type—the data would have defloated. If you then clicked

again—maybe you were working too quickly or hadn’t noticed that you dropped the selection—you would

have permanently rendered that selection into the layer and would therefore have to recreate the work. And

that includes redoing the work put into the layer that was compromised by the floating selection.

Instructors who teach Photoshop and authors of books about the application have taught their students to

convert the floating selection into a layer immediately, which reduces the risk of making a mistake that will

cost valuable time.

Now, do the same task in Photoshop 4.0:

1. Paste an object or create some text.

Notice that Photoshop 4.0 makes a layer and nothing is selected, so there’s no need to hide edges.

2. Select a portion of the layer and then modify the selection, adding and subtracting from it.

Note that because this is a layer, you can make a selection normally, having all the available data

to work with.

3. When done, press Delete to remove the unwanted pieces.

4. Deselect.

5. Hold down the Command (Mac)/Ctrl (Win) key, or select the Move tool and drag the data

into position.

Photoshop 4.0 now does what most teachers instruct their students to do: It makes a layer, which makes it

much more difficult for users to make mistakes. In the Photoshop 4.0 example, you can select and modify

the selection as often as you want and then, when done, press Delete to remove unwanted portions.

Of course, by pasting as a layer, you immediately lose the selection. You cannot grab inside the selection to

move it around because “nothing” is selected. (In Photoshop 3.0, the same issue exists. Once a user turned a

floating selection into a layer, it was immediately deselected.)
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This is where the Move tool comes in. (We’ll discuss its use in detail, later.) Because Photoshop 4.0 now pastes

as layers—which yields fewer mistakes—and because it composites faster, given the new image cache scheme,

we felt it was important to not force users to constantly select the Move tool from the toolbar to position

their layered elements. So we made one key toggle to the Move tool, no matter what tool was selected. Modeling

this change on Adobe Illustrator, we chose to use the Command/Ctrl key, easy for any user to remember and to

work with.

Big Data
Big Data is very simple: Photoshop 4.0 will never clip the data beyond the borders of the canvas. In

Photoshop 3.0, any image data positioned off the edge of the canvas would be automatically deleted.

Big Data is incredibly beneficial to the creative process. You no longer have to worry about defloating selections

too early, which means that you will make fewer mistakes and spend less time starting over from scratch to

create an effect.

Try this in Photoshop 3.0:

1. Create some large text on the canvas.

Photoshop 3.0 makes a floating selection out of the text.

2. Rotate the text and scale it so that it is larger than the canvas.

Note that this takes two steps and two resamples.

3. After applying the transformations, place the text so that one portion of it bleeds off the canvas.

4. Drag the floating selection onto the new layer icon and make it a layer.

5. Now select one of the letters with the Lasso tool, and with Preserve Transparency on, fill the letter with

a color.

6. Grab the Move Tool and move the text.

Note that the edges of the text are clipped to the canvas size.

Do the same task in Photoshop 4.0:

1. Create some large text on the canvas.

Photoshop 4.0 makes a layer out of the text, eliminating the extra step of dragging it to the new layer icon.

2. Rotate the text and scale it so that it is larger than the canvas.

This is done in one step and one resample, thanks to the new Free Transform command.

3. After applying the transformations, place the text so that one portion of it bleedsoff the canvas. You’ll

need to use the Move tool, which you can easily access by holding down the Command/Ctrl key.

4. Now, select one of the letters with the Lasso tool, and with Preserve Transparency on, fill the letter with

a color.

5. Deselect, and then use the Move tool to move the text.

Note that even the text that was off the edge of the canvas remains intact.

In Photoshop 3.0, had the type not been placed exactly where you needed, you would have to repeat these

steps over and over until it was positioned correctly—a very time-consuming process. In Photoshop 4.0, you

can experiment as often as you want and not worry about data getting clipped.

One additional tip: To eliminate extra data around the edges of the canvas in order to save disk space, simply

select all, and then choose Crop from the Image menu.
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The Move Tool
When layer support was added in  Photoshop 3.0, the Move tool was also introduced. While the Marquee

tool was still used to move selected image data within a layer, the Move tool was designed for repositioning

an entire layer within the composition.

Old habits die hard, however, and many users of version 3.0 continued to use the Marquee tool, even when

moving the contents of an entire layer. Many times, users would load the transparency mask of a layer, and

then grab it with the Marquee tool and move it. This created “ghosted” edges, which hampered photorealism.

To get around that problem, some users learned to select all and then grab the selection with the Marquee

tool. Frequently users wanted to nudge a layer by small increments, so instead of switching to the Move tool

and using the cursor keys, they would select all and use the Arrow keys to nudge layers or elements into place.

While these Marquee-based methods worked, their results were often inferior to what could be achieved with

the Move tool. Because the Move tool did not require a selection in order to move data, it avoided the edge

artifacts that were sometimes introduced by the Marquee tool.

As Photoshop 4.0 was in the design stages, it became apparent that confusion between the Marquee tool and

the Move tool could become more of a problem. With Photoshop pasting as layers, users would need to switch

to the Move tool constantly, because layers come in with no data selected. Because of the Big Data feature,

using Select All with the Marquee tool was no longer an acceptable option; doing so could result in data

being stranded outside the canvas area when the data inside was moved. Finally, Photoshop 4.0 would have

guides, which have to be moved around somehow, and the Marquee tool could not be used to move guides

because it was supposed to snap to them when drawing selections.

Taking all of this into consideration, a decision was made to consolidate the entire move function—whether

selections, guides, paths, or layers—under one tool, and one tool only: the Move tool. Now, to move things,

you have to use the Move tool. And with access through the Command/Ctrl key it’s fairly easy to do so.

This change yielded a set of new benefits. Since the Marquee tool no longer moves pixel data, it allows you

to more easily use the marching ants as a mask to work in. To move the Selection marquee without moving

pixel data in Photoshop 3.0, you had to remember an obscure Option+Command/Ctrl+Alt keyboard short-

cut. Now, using the Marquee tool, you can simply drag the marching ants into whatever position you want,

or use the Arrow keys to move them. To move data, you hold down the Command/Ctrl key to toggle to the

Move tool, or select the Move tool from the Tool palette after completing your selection.

This means you can work more with selection shapes without having to worry about accidentally picking up

and moving pixels with the same tool you use to draw the shapes in the first place.

Try this in Photoshop 3.0:

1. Place an EPS logo into a document as its own layer.

2. Open a second document with a texture in the background.

3. In the document with the EPS graphic, use Command+Option+T/Ctrl+Alt+T to load the transparency

mask.

4. Copy.

5. Choose the second document and Paste.

6. Go to the Channels palette and then click the mask icon to save the shape as a selection.

7. Delete the floating selection from the Layers palette.

8. Option+click/Alt+click the channel in the Channels palette.

9. Run a filter on the document to use the shape.
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To create the same effect in Photoshop 4.0:

1. Place a logo into a document as its own layer.

2. Open a second document with a texture in the background.

3. In the document with the EPS graphic, Command/Ctrl+click the EPS layer thumbnail to load the

transparency mask.

4. With the Marquee tool selected, drag and drop the shape into the texture document.

5. Run a filter on the document to use the shape.

If you like, you can still save the shape as a channel by clicking the mask icon in the Channels palette to save

for future use. The point here is that working with selections as a shape is more fluid in Photoshop 4.0, since

the Marquee tool no longer moves pixels. Moving the shape of one layer to another document is just one

small example of this.

Here’s another benefit of using the Command/Ctrl key to toggle to the Move tool, no matter what tool you

have selected.

Try this in Photoshop 3.0:

1. With the Type tool selected, create some text.

2. Turn on Preserve Transparency.

3. Fill with black.

4. Duplicate the layer.

5. Fill the new layer with a color.

6. Select the layer underneath. (You can use Command+[/Ctrl+[ here.)

7. Switch to the Move tool. (Press “V,” or select the tool itself.)

8. Use the Arrow keys to nudge the layer around.

Now, the same technique in Photoshop 4.0:

1. With the Type tool selected, create some text.

2. Fill with black. (Text layers have Preserve Transparency automatically on when created.)

3. Duplicate the layer.

4. Fill the new layer with a color using the same keyboard shortcut.

5. Select the layer underneath. (This is now Option+[/Alt+[.)

6. Use Command/Ctrl+Arrow keys to nudge the layer into position.

Photoshop 4.0 doesn’t force you to switch tools constantly in order to move entire layers or to make finely

tuned adjustments.

Merge Down/Linked/Grouped
Given that pasting now makes layers instead of floating selections, Photoshop 4.0 needed a more flexible set

of merging commands to keep layers tidy and under control. So the commands Merge Down, Merge Linked,

and Merge Grouped were developed.

The Merge Down command (Command+D/Ctrl+D, which can be executed with one hand) lets you quickly

take pasted layers and merge them as if you were defloating a selection.
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Added to Merge Down is Merge Linked and Merge Grouped. Merge Linked replaces Merge Down if a layer

within a linked list of layers is selected. Merge Grouped replaces Merge Down if the layer selected is the clip-

ping layer of a group.

The old Merge Layers command works the same, but has been labeled more appropriately as Merge Visible,

because it discards any layers that are hidden.

Selection Math
Anyone who has used Photoshop since 1.0 knows that when the Marquee tools are selected, Shift allows you

to add to the selection, Command/Ctrl subtracts from the selection, and Command+Shift/Ctrl+Shift inter-

sects the selection. Option/Alt would duplicate the selection, and Command+Option/Ctrl+Alt would move

only the selection mask itself, and not any pixels.

Given that in Photoshop 4.0 the Command/Ctrl key is used to toggle to the Move tool from any tool, includ-

ing the Marquee tools, the subtract function was shifted to the Option/Alt key. The selection math still exists,

but now the functionality is Shift to add, Option/Alt to subtract, and Option+Shift/Alt+Shift to intersect.

Traditionally, most Photoshop users think of Option/Alt as “duplicate.” This key still means “duplicate” in

Photoshop, but because moving pixels is a function that only the Move tool can do, Option/Alt duplicates

only with the Move tool. (Or, if you have the Marquee tool selected, Command+Option/Ctrl+Alt duplicates.)

This change has an effect on other parts of the program. The Channels palette in Photoshop 3.0 allowed

you to Option+click/Alt+click the thumbnail to load that channel as a selection. In keeping with the selection

math, Option+Shift/Alt+Shift added the channel to the current selection, Command+Option/Ctrl+Alt sub-

tracted, and Command+Option+Shift/Ctrl+Alt+Shift intersected.

With the new selection math, where Option/Alt now means subtract, the Channels palette shortcuts stay

consistent. Now, in Photoshop 4.0, Command+clicking/Ctrl+clicking the thumbnail loads the channel as

a selection, Command+Shift/Ctrl+Shift adds to the selection, Command+Option/Ctrl+Alt subtracts, and

Command+Option+Shift/Ctrl+Alt+Shift intersects. (Short cursor annotations help you keep these new

shortcuts in mind.)

These selection shortcuts were also added to the Layers palette and to the Paths palette. Now you can simply

click the thumbnails to create complex selections without ever having to open the Load Selection dialog box.

Try this in Photoshop 3.0:

1. Open a layered file, such as the Postcard image that comes with Photoshop 3.0.

2. Select the Leaf layer.

3. Press Command+Option+T/Ctrl+Alt+T to load the transparency of the Leaf layer.

4. Select the Sun layer.

5. Open the Load Selection dialog box.

6. Select Sun transparency and the “Add” option, and then click OK.

7. Select the Flower layer.

8. Open the Load Selection dialog box.

9. Select Flower transparency and the “Add” option, and then click OK.

10. Make a new layer just above the background.

11. Fill the selection with black.

12. Deselect.

13. Grab the Move tool and then offset the new shadow layer.
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This procedure is just one approach. You also could have saved off channels to produce the same result. Doing

that would look like this:

1. Open a layered file, such as the Postcard image that comes with Photoshop 3.0.

2. Select the Leaf layer.

3. Press Command+Option+T/Ctrl+Alt+T to load the transparency of the Leaf layer.

4. Go to the Channels palette and then click the mask icon to save the selection as a channel.

5. Go to the Layers palette and select the Sun layer.

6. Press Command+Option+T/Ctrl+Alt+T to load the transparency of the Sun layer.

7. Go to the Channels palette and then click the mask icon to save the selection as a channel.

8. Go to the Layers palette and select the Flower layer.

9. Press Command+Option+T/Ctrl+Alt+T to load the transparency of the Flower layer.

10. Go to the Channels palette and then click the mask icon to save the selection as a channel.

11. In the Channels palette, Option/Alt+click the Leaf channel thumbnail.

12. Option/Alt+Shift+click the Sun channel thumbnail.

13. Option/Alt+Shift+click the Flower channel thumbnail.

14. Go to the Layers palette and make a new layer just above the background.

15. Fill the selection with black.

16. Deselect.

17. Select the Move tool. (Or press “V.”)

18. Offset the new shadow layer using the Arrow keys.

As you can see, both methods are fairly cumbersome.

Here’s the same technique in Photoshop 4.0:

1. Open a layered file such as the Postcard image that comes with Photoshop 3.0.

2. Command/Ctrl+click the Leaf thumbnail.

3. Command/Ctrl+Shift+click the Sun thumbnail.

4. Command/Ctrl+Shift+click the Flower thumbnail.

5. Make a new layer just above the background.

6. Fill the selection with black.

7. Deselect.

8. Use Command/Ctrl+Arrow keys to offset the new shadow layer.

The method for Photoshop 4.0 is fairly powerful, intuitive, and much faster than 3.0. This new set of short-

cuts will greatly speed up the way people create selections in Photoshop.

Operations that use the Eyedropper tool, such as Color Range, were also affected by the selection math

change. Now Shift adds and Option subtracts (and changes the Cancel button to Reset).

Layer via Copy/Layer via Cut
The old Float command is now replaced with Layer via Copy and Layer via Cut, found in the Layer>New

submenu. This change follows the logic of making layers instead of floating selections, and it also makes

edits less error-prone, because layers do not clip at the edges of the canvas anymore.

Layer via Copy was assigned the former Float shortcut key command of Command+J/Ctrl+J, while the

modifier, Shift, produces Layer via Cut.
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Changes to Layer Masks
In Photoshop 3.0, you had the option of changing what the meaning of the color (or black) did in a layer

mask by choosing the Block or Reveal settings. This confused many users, and for the most part, they left

the settings alone.

In Photoshop 4.0, layer masks are even more important, because the new Adjustment Layers feature relies

on the masks to determine what part of the image is affected. For this reason, we improved how layer masks

worked so that users not familar with them could produce expected results.

We simplified the layer mask functionality by making black always mean Block while white always means

Reveal, in keeping with the way most artists and photographers work—and because this technique is similar

to how people use alpha channels.

We made two other changes to make layer masks work as needed under all cases: Now you can make layer

masks in one of four ways, depending on context; and the default foreground and background colors are

different than they are when you’re working in RGB/CMYK data.

When a layer mask is made, one of four things happens. If there is no selection on-screen, the layer mask is

created as “Reveal All” or “Hide All.” Reveal All creates a layer mask that is all white, and therefore leaves

visible what is seen on the layer. You then erase what you don’t want. Hide All makes a layer mask that is all

black, and therefore hides the whole layer, letting you paint in portions of the layer.

The catch here is that if a layer mask is made as Reveal All, then dragging it around on-screen with the Move

tool extends the edges of the mask with white, making sure no holes are created. The opposite happens when

Hide All: Black is used to extend the edges.

The other two menu items—Reveal Selection and Hide Selection—appear when a selection is present.These

are shortcuts for making correct layer masks after making a complex selection.

The Mask button at the bottom of the Layers palette creates masks by one of four options:

1. With no selection, a simple click performs Reveal All, which is the most common method of using

layer masks.

2. With a selection, a simple click performs Reveal Selection, which is the second most common method

of using layer masks.

3. With no selection, Option+click/Alt+click performs Hide All, which is the third most common case

of using layer masks.

4. With a selection, Option+click/Alt+click performs Hide Selection, which is the least common case

of using layer masks.

Options 1 and 2 above also apply when creating adjustment layers. When a selection is present, the adjust-

ment layer is created with a mask that affects only the selected area.

The final change made to layer mask functionality is that when you press the “D” key to get default colors, if a

layer mask is targeted, the colors are reset to white as foreground and black as background. This was done so

that the paintbrush would paint white by default, which reveals effects in layer masks, and so that the Eraser

tool would erase effects from layer masks because it would paint black. (We expect, however, that some users

will continue to use the paintbrush and switch colors with the “X” key shortcut.)

Spacebar While Drawing
When drawing with the rectangular or elliptical Marquee tools you can now hold down the spacebar while

drawing to move the rectangle or ellipse. This makes it much easier for you to get the result you need when

using these two tools.
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Free Transform
The new Free Transform feature allows for easier placement of scaled, rotated, or sheared data. It produces

better image quality because the data is resampled in one pass. The Free Transform feature is also easier to

use than the equivalent tools in Photoshop 3.0.

The Gavel and Cancel tools—used in version 3.0 to accept or reject a transformation using the mouse

button—have been removed from Transformations. It was more important to let users move and rotate

transformations intuitively without the use of shortcut keys. With this change, the Rotate command works

anywhere outside the area being transformed, and the Move command works anywhere inside.

How do you apply or cancel the transformation? By means of the Return/Enter and the Command+ period/

Esc keys, respectively. This is consistent with how changes are applied everywhere else in the program.

Once you know that Return/Enter and Command+ period/Esc are Apply and Cancel commands, using

Free Transform is fairly straightforward—and very powerful.

We decided to make the Crop and Place commands work the same way. This change makes these functions

much easier to use for more precise work and also makes Photoshop 4.0 functionality more consistent.

We also separated the Rotate and Flip functions for the whole image as commands under the Image menu.

The Rotate command in the Layer menu now rotates only the current layer or the selection, if one is present.

New Features for Linked Layers
Linking layers now lets you perform transformations across the linked set of layers. This enables you to keep

data as layers, and then choose Free Transform to distort, scale, or rotate everything simultaneously.

Now you can also drag and drop multiple layers into other documents and maintain registration among the

layers. (This operation required a keyboard shortcut in Photoshop 3.0, which has now been removed in 4.0.)

Linking layers maintains the relative registration of the layers that are copied, so there’s no need to remember

any shortcut keys when you’re dragging and dropping linked layers from one document to another. If you

drag and drop linked layers between documents of the same size and you want those layers to line up similarly

across the two documents, you can hold down the Shift key while performing the operation.

Showing Composite Data
Command+0/Ctrl+0 was changed to Command+~/Ctrl+~ to view composite data. The logic behind this was

to let Photoshop use Command+0/Ctrl+0 for Fit on Screen, a command that will become standard in the

Adobe suite of graphics applications. (Adobe PageMaker® 6.5 uses this command, as will the next version of

Adobe Illustrator.®) Also, Command+~/Ctrl+~ is easier to execute with one hand and makes more logical

sense given the keyboard layout. This change is also reflected in dialog boxes.

Context-Sensitive Menus
The Photoshop 4.0 interface now offers users context-sensitive menus. On the Macintosh platform, you use

the Control key to access the menus. On Windows® platforms, you access these menus using the right mouse

button (standard Windows mouse behavior). Experimenting with the context-sensitive menus can acquaint

you with options that were difficult to locate in earlier menu structures.

“Spot Selecting” the Top Visible Layer
In Photoshop 3.0, using the Command/Ctrl key with the Move tool, you could click the document to target

the topmost, most visible layer at the point you clicked. In Photoshop 4.0, this feature has been expanded.

Pressing the Command/Ctrl key now takes you to the Move tool, no matter what tool is selected. Control+click

(Mac) or the right mouse button (Win) gives you context-sensitive menus. So Control+clicking (Mac) or

clicking the right mouse button (Win) with the Move tool returns a pop-up menu of all visible layers below

the point clicked. And Command+clicking (Mac) or Ctrl+clicking the right mouse button (Win) does the

same thing with any tool selected.
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To bypass the pop-up menu, hold down the Option/Alt key. This new method lets you target layers without

ever having to mouse over to the Layers palette, no matter what tool is selected or even if the layer is obscured

by another layer.

Tool Palette Changes
Photoshop 4.0 sports a new layout for the tools on the Tool palette. This change was made to create consis-

tent tool palettes among all Adobe applications. You’ll notice that the Hand and Magnifying Glass tools were

moved to the bottom of the palette. You can expect to find similar tools grouped with each other and in

similar locations, as you switch from one Adobe product to another.

Layers Palette Changes
Many changes were made to the Layers palette, some of which are subtle. In Photoshop 3.0, a light gray color

was used in the list to indicate that a layer was selected. At first, this confused many people who were trying

to learn how to use layers, and the color was so subtle that it was often missed. On Windows, the look was

reversed, causing some confusion across platforms about what indicated that a layer was selected.

In Photoshop 4.0, the highlight color, set in the Color control panel in the MacOS and in the desktop proper-

ties panel in Windows 95/Windows NT,® is the selection color in all list views. This lets you set the color you

prefer to indicate selected items.

Like other areas of the program, the Layers palette required some shortcut key changes. In Photoshop 3.0, the

Command/Ctrl key toggled a layer mask on and off. The Command/Ctrl key now loads the mask as a selec-

tion. So the functionality of toggling the layer mask on and off was moved to the Shift key in Photoshop 4.0.

In Photoshop 3.0, the Shift key turned on Quick Mask mode for layer masks. In Photoshop 4.0, that function

is mapped to Option+Shift/Alt+Shift. The Option/Alt key in Photoshop 4.0 still toggles the layer mask view,

as it did in earlier versions.

Clipping Groups was a little used feature in Photoshop 3.0, due in large part to the obscure way a clipping

group was created; by holding down the Option/Alt key over the line separating two layers. In Photoshop 4.0,

this shortcut still works, but a Group command was added to the menus so that users could more easily

access the feature. Also, clipping groups are visually indented in the palette to better indicate which layers

are grouped together.

Finally, a paintbrush icon was added to the right of the eye icon. This icon changes to a mask icon, depending

on whether you have selected the paint layer or its layer mask. Because it can be difficult to see the thick black

line around the thumbnail of the layer or its mask (to see what’s being painted on) this icon helps to show

what is going on. Additionally, with thumbnails turned off, this icon helps to show what is targeted.

Paths Palette Changes
One of the first things people notice when they open the Paths palette is that the Pen tools are no longer

located across the top of the palette. These tools were relocated to the Tool palette, where they resided before

Photoshop 3.0.

One of the benefits of doing this was that the Paths palette no longer needs to be on-screen in order for you

to use the Pen tool. If you know keyboard shortcuts, this can make using Paths more efficient, because you

don’t need to keep both the Layers and the Path palette open to do paths and layers work simultaneously.

Also, paths now draw into the work area, the light gray background area that extends beyond the canvas when

a window is sized larger than the current canvas size. This lets you draw paths into that area to create better

bleeds, as well as manipulate control handles that need to extend into the edges.
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Info Palette Changes
The Info palette was redesigned so that it no longer resizes dynamically, and so that it fits into a palette cluster

more effectively. The dynamic resizing behavior of Photoshop 3.0 meant that you often had to move the

palette around on-screen to get visual access to information that was appearing off the screen or below other

palettes. This new layout prevents that. You will notice that the X and Y fields and the W and H fields do not

change location within the Info palette as selections are made, dragged, or moved, as they did in the Info

palette in Photoshop 3.0.

Changes to the Indexed Color Dialog Box
The Indexed Color dialog box was redesigned and streamlined to better explain what will happen when an

image is converted from RGB/CMYK to indexed color. Photoshop 3.0 software’s set of clustered buttons that

dimmed automatically caused some confusion about how indexed color worked and did not explain why

some options were not available given certain conditions.

The new layout of Photoshop 4.0 leads you through a procedure: First you choose a type of palette. If the

image can contain an exact palette, Photoshop will default to those settings. After you choose a palette, you

then choose a color depth and the number of colors, if available. These items are dimmed out or become

noneditable in circumstances where they do not make sense. And, in Photoshop 4.0, when you choose a

predefined bit depth, you see the number of colors that translates to in the Colors field.

Both the MacOS and the Windows systems palettes are now available to you, regardless of the platform you’re

using. In addition, the “Web palette” of 216 colors, previously available on Adobe’s Web site, is now built into

Photoshop 4.0.

Image Size Dialog Box Changes
The Image Size dialog box was redesigned for users who want to create graphics for the Web and for multi-

media production, and also to streamline how changes to an image’s size and resolution can be scripted.

In the new Image Size dialog box layout, the width and height of the image are displayed in pixels at the top

of the dialog box at all times. Below is the size in standard units of measure (i.e., inches, centimeters, picas,

and points) as well as the resolution setting.

The words “file size” have been replaced with the term “resample” to more clearly indicate that changing the

file size requires resampling. If the Resample checkbox is off, the pixel size at the top of the image becomes

static, indicating that when resolution or print size values are changed, no resampling of the pixels occurs;

only the final printed output will change. With the Resample checkbox turned on, all the fields become active,

and changes in pixel size, print size, and resolution result in changes in other fields, which could cause some

pixel resampling to occur. In short, if you would have enabled the Constrain File Size option in Photoshop

3.0, then disable the Resample option in version 4.0.

For those who work in graphics, multimedia, or Web production, a pixel value across the top is all that is

really needed, because printed resolution has no meaning on-screen. For those doing printwork, this new

layout will better explain the relationship between an image’s pixel dimensions and its final printed dimensions.

Finally, the resampling method option was added to the Image Size dialog box so that you can pick the

resampling method you want without constantly switching back to the Preferences dialog box.
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Command Key Changes
Some users will wonder why certain keyboard shortcuts were moved around in the menu structure. Some

commands will be shared across Adobe applications, and those commands will now use the same keyboard

shortcuts so that users won’t have to spend time learning multiple sets of commands.

If an application implements any of the features listed below, the keyboard commands are as follows:

Command MacOS Windows

Zoom In Cmd + Ctrl +

Zoom Out Cmd - Ctrl -

Fit in Window/Screen Cmd 0 Ctrl 0

Actual Size† Cmd 1 Ctrl 1

Show/Hide Rulers Cmd R Ctrl R

Show/Hide Guides Cmd ; Ctrl ;

Snap-to Guides Cmd Shift ; Ctrl Shift ;

Lock Guides Cmd Option ; Ctrl Alt ;

Show/Hide Grid Cmd “ Ctrl “

Snap-to Grid Cmd Shift “ Ctrl Shift “

Bring to Front Cmd Shift ] Ctrl Shift ]

Bring Forward Cmd ] Ctrl ]

Send Backward Cmd [ Ctrl [

Send to Back Cmd Shift [ Ctrl Shift [

Select All Cmd A Ctrl A

Deselect All† Cmd Shift A Ctrl Shift A

Group Cmd G Ctrl G

Ungroup Cmd Shift G Ctrl Shift G

Toggle Palettes Tab Tab

Toggle Palettes (except Tools) Shift Tab Shift Tab

Pan Image Spacebar Spacebar

Zoom In with Tool Spacebar Cmd Spacebar Ctrl

Zoom Out with Tool Spacebar Cmd Option Spacebar Ctrl Alt
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† Due to historical uses, Photoshop 4.0 did not implement these particular shortcuts. They are the same as they were in
Photoshop 3.0.
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